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About DeltaLINK 
DeltaLINK is the PC software for setting up and downloading data from DL6 and GP1 data 
loggers.  

What’s new in DeltaLINK 2.6 

1. Support for SM150 soil moisture sensor. 

2. DeltaLINK program, various corrections and improvements: 

a. Corrected displaying of connection details in DeltaLINK status bar, previously 
connection details were only partly updating. 

b. Corrected connection start-up settings, on some PC the start-up connection 
setting were not loaded correctly, and defaulted to use last successful 
connection. 

c. DeltaLINK, various optimizations in chart view, data cache, and downloading 
dataset. 

3. DL4CmdLine utility, various corrections and improvements: 

a. Added tab-separated data text files, use .txt extension for dataset file or use /X 
switch when using auto-generated filenames for multiple loggers in a single 
command line. 

b. DL4CmdLine now only requires only DL4Api.dll to run, so can be run on PC 
without installing DeltaLINK. 

c. Timestamps consistently written to logger errors and log file in default format for 
locale. Previously a mixture of locale-default and “YYYY-mm-dd hh:mm:ss”. Auto-
generated file name format retained as locale-default format is not guaranteed to 
provide seconds, so could lead to overwriting. 

d. Error log output to screen was untidy, so has been removed. 
e. ‘Hidden’ measurements excluded from error log. 
f. Removed trailing space from measurement names in error log 

Compatibility 

DeltaLINK 2.6 is fully backward compatible with earlier firmware and DeltaLINK versions, i.e. 
it can communicate with, and open programs and datasets from earlier versions.  

However, programs created in DeltaLINK 2.6 are incompatible with earlier firmware versions 
than 1.48: 

a. You must upgrade loggers with earlier firmware if you want to re-program them with 
DeltaLINK 2.6.  

See Firmware Upgrade below for instructions. 

b. You can use DeltaLINK 2.6 to retrieve and view data created by earlier firmware versions 
without upgrading the firmware. 

c. Firmware 1.48 was supplied with DeltaLINK 2.4, so: 

 DeltaLINK 2.6 Setup replaces DeltaLINK 2.4 and 2.5. (You may need to delete shortcuts 
from the earlier version. See Known Issues, below). 

 DeltaLINK 2.6 installs side-by-side with DeltaLINK versions earlier than 2.4. This allows 
you to continue using earlier firmware versions with the older DeltaLINK if you don’t want 
to upgrade. 

d. With a 1.48 firmware logger, you can download and view data with pre-2.4 DeltaLINK 
versions, but you can’t view or change its program. 
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Installation 

System Requirements 

To install and use DeltaLINK software for the DL6 and GP1 logger you need: 

 A PC running Windows XP, Vista, Windows 7. 

 50MB of available hard disk space. 

 One free RS232 serial port or USB-RS232 adapter. 

 DL6 or GP1 RS232 cable (supplied with the logger). 

To Install DeltaLINK 

You need local administrator rights to install DeltaLINK 2.6. Please contact your system 
administrator for further information. 

Select the Install DeltaLINK 2.6 link in the Contents page of the Delta-T Software and 
Manuals CD and follow the on-screen instructions. 

Alternatively, download DeltaLINK 2.6 from www.delta-t.co.uk and click Run when the 
download completes. 

The installation program creates a DeltaLINK 2.6 desktop shortcut, and a DeltaLINK 2.6 
program group in the Windows Programs menu which contains the following shortcuts: 

 DeltaLINK 2.6   for setting up, controlling, retrieving and displaying logged data 

 Firmware Upgrade   upgrades logger firmware to the most recent version 

 GSMConfig Utility   sets up the Delta-T GSM Modem System for use with DeltaLINK 

 Document Library   opens a folder of application notes and technical documents 
which supplement the DeltaLINK online Help and the logger Quick Start Guide. 

To Start DeltaLINK 

1. Connect the logger to the PC’s serial port (preferably COM1) using the DL6 or GP1 
RS232 cable supplied with the logger. 

2. Double-click the DeltaLINK icon on the desktop. 

3. DeltaLINK attempts to connect to a logger. If successful, DeltaLINK shows information 
about the logger in the Logger window. 

4. If you have a fresh installation, DeltaLINK attempts to use COM1. If the connection fails 
because the logger is connected to the wrong serial port select File, Properties. Click 
New... to create a connection which uses the correct serial port. Press F1 or click Help for 
more information. 

Firmware Upgrade 

To upgrade to the current firmware version: 

1. In DeltaLINK, stop logging, retrieve any stored data and delete all dataset records. 

2. Close DeltaLINK. 

3. From the Windows Start menu select Firmware Upgrade in the DeltaLINK 2.6 program 
group, and follow the on-screen instructions. 

WS-GP1 Weather Station Program 

The firmware upgrade process restores the default GP1 program (i.e. the GP1 weather 
station program is lost). To re-program the logger as a weather station, connect to the GP1 in 
DeltaLINK and follow the below steps: 

1. Select the Program page and click Change. 

2. Select Edit > New Program… (NB: Not File > New Program…). 

3. In the Program Type list, select WS-GP1 Weather Station Program. 

4. Select the weather station options that you want to record. 

5. Click Apply to update the logger in the normal way. 

http://www.delta-t.co.uk/
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Dataset Import Wizard 

Dataset Import Wizard imports DeltaLINK datasets into Microsoft Excel spreadsheets.  

To install Dataset Import Wizard select the Install Dataset Import Wizard link in the 
Contents page of the Delta-T Software and Manuals CD and follow the on-screen 
instructions.. 

Known Issues 
The following defects have been identified and will be addressed in forthcoming upgrades, 
which will be available from www.delta-t.co.uk. 

1. When replacing an earlier version, DeltaLINK Setup leaves behind a shortcut to the 
Document Library folder of the previous version. This folder is empty – unless you have 
copied or moved files into it. If so, it can be safely deleted together with the shortcut. All 
other shortcuts, files and folders are correctly removed and replaced by the current 
version. 

Revision History 

DeltaLINK 

DeltaLINK 2.6 

DeltaLINK 2.6 is the current version of DeltaLINK: 

1. Support for SM150 soil moisture sensor. 

2. DeltaLINK program, various corrections and improvements: 

a. Corrected displaying of connection details at bottom of DeltaLINK window, 
previously connection details were only partly updating. 

b. Corrected connection start-up settings, on some PC the start-up connection 
setting were not loaded correctly, and defaulted to use last successful 
connection. 

c. DeltaLINK, various optimizations in chart view, data cache, data download. 

3. DL4CmdLine utility, various corrections and improvements: 

a. Added tab-separated data text files, use .txt extension for dataset file or use /X 
switch when using auto-generated filenames for multiple loggers in a single 
command line. 

b. DL4CmdLine now only requires only DL4Api.dll to run, so can be run on PC 
without installing DeltaLINK. 

c. Timestamps consistently written to logger errors and log file in default format for 
locale. Previously a mixture of locale-default and “YYYY-mm-dd hh:mm:ss”. Auto-
generated file name format retained as locale-default format is not guaranteed to 
provide seconds, so could lead to overwriting. 

d. Error log output to screen was untidy, so has been removed. 
e. ‘Hidden’ measurements excluded from error log. 
f. Removed trailing space from measurement names in error log 

DeltaLINK 2.5.1 

1. Corrects a problem with cancellation of Read Now which was present in DeltaLINK 2.5. 

DeltaLINK 2.5 

1. BF5 Sunshine Sensor support: DeltaLINK offers ‘BF3, BF5 Sunshine Recorder’ program. 

2. DL4CmdLine.exe command line: can be used in batch files and/or in conjunction with 
Windows Scheduled Tasks to automate dataset retrieval. See application note ‘Command 
line utility for automating dataset retrieval v1.0.pdf’ in the DeltaLINK document library 
(select the Document Library shortcut from the DeltaLINK 2.5 program group in the 
Windows Start menu). 

file://dtsrvr2/groups/version%20control/private/manuals/DeltaLINK/PC/DeltaLINK-PC%20Release%20Notes/Draft/www.delta-t.co.uk
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3. Connection to a logger and data retrieval is speeded up by caching programs and 
datasets from earlier sessions. 

4. A status bar displays Connection details together and provides a button for changing the 
logger connection (as File, Properties command).  

5. The Connections dialog provides connection start up options. These are alternatives to 
using the last successful connection, as in earlier versions. 

6. The known issue ‘Unable to Allocate Memory for FlexGrid’ has been resolved and the 
Table view can now display large datasets. 

Version 2.4 

1. Support for SM300 soil moisture sensor. 

2. Enhanced Control features in Standard GP1 and DL6 programs: 

a. SINCE SWITCHED condition for limiting the maximum and minimum repeat rate and 
duration of relay activation and deactivation. 

b. Totalizing counter-based measurements in Control conditions 

c. Named Control values which can be adjusted while the program runs, i.e. without 
stopping and re-programming the logger. 

See Application Note ‘Irrigation and Control features in DeltaLINK 2.4’. Start DeltaLINK 
and select Help > Document Library command.  

3. DL6 and GP1 simulators for experimenting with effects of Control conditions, rapid 
generation of datasets (e.g. for developing data processing regimes), and predicting 
memory usage. Start DeltaLINK and see Help topic ‘How To… Run GP1 and DL6 
program simulations’. 

4. Firmware upgrade version 1.48 is provided with DeltaLINK 2.4.  

5. Corrected importing of WET calibration and user-defined linearization table files non-
English Windows installations (‘.’ decimal separator is required in user-defined 
linearization tables, as in the specimen files provided with DeltaLINK). 

DeltaLINK 2.3.2 

DeltaLINK 2.3.2 is a service release to improve DeltaLINK’s communications stability with 
loggers over long cables either directly connected to the computer of via modems. 

DeltaLINK 2.3.1 

DeltaLINK 2.3.1 is a service release, which addressed the following issues in DeltaLINK 2.3. 

1. Correction to % soil moisture measurements in Standard GP1 programs. Previously, 
when modifying a program (i.e. a program installed in a GP1 or previously saved to disk), 
the % calculation wasn’t applied correctly. Note that DL6 programs, and newly created 
GP1 programs were not affected. 

2. Correction to Firmware Upgrade: the upgrade supplied with DeltaLINK 2.3 wasn’t able to 
upgrade from firmware versions earlier than 1.31. 

3. Chart window resizing: when increasing the size of the DeltaLINK window, charts are 
automatically scaled to better utilize the display area. 

Version 2.3 

1. WS-GP1 Weather Station program together with enhanced charting facilities for weather 
station data including wind roses, bar charts, and maxima and minima. 

2. Extended sensor support in Standard GP1 programs: 

a. WET sensor: requires GP1-06-001 or later. Refer to WET GP1 Logging v1.2.pdf in 
the DeltaLINK Document Library.  

b. Temp3 and Temp4 channels can be used for SM200 sensors, allowing up to 4 
SM200s to be connected to the GP1. 

c. Event5 channel can be used for measuring frequency. The signal is measured over a 
200 ms sample period, so is suitable for sensors with a kHz output. 
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d. Precision 5V excitation is available for powering sensors, as an alternative to 
switched power. 

3. Timing in Standard GP1 programs: 

e. Recording delay allows program actions to be offset from ‘natural’ recording rate 
boundaries, e.g. every hour at 10 minutes past the hour. 

f. Time of day can be used in Control conditions. 

4. Logger firmware versions and DeltaLINK compatibility:  

g. Current versions are GP1 v1.46 and DL6 v1.31. Firmware Upgrade (above) describes 
how to upgrade existing loggers. 

h. To program a logger with DeltaLINK 2.3 the current firmware version must be 
installed in the logger.  

i. Other DeltaLINK 2.3 features are compatible with earlier firmware versions.  

j. DeltaLINK 2.3 installs ‘side by side’ with earlier DeltaLINK versions, so it’s only 
necessary to upgrade existing logger firmware if you want make use of the new 
program features in DeltaLINK 2.3. 

5. Firmware Upgrade supports logger networking. 

6. Added support for use of COM ports greater than COM10. 

Version 2.2 

Version 2.2 provides the following additional features: 

Standard GP1 and DL6 programs: 

1. Control Page: the active state of the Control relay can be set to open or closed. 

2. Condition dialog: counter channels can be selected in Control conditions. Note that 
counter channel readings are cumulative during the course of a recording period, so 
Control relay switching will track the incrementing and resetting of the counter.  

3. Dual Rate page: accelerated recording rate can now be triggered by activation of the 
Control relay, and by GP1 Event5 channel. When triggered by the Control relay, 
accelerated recording (of soil moisture channels only), starts when the relay is activated 
and persists for a holdoff period after the relay is deactivated, and until soil moisture 
readings stabilize. 

4. Alarm page: the initial state of the Alarm relay can now be set to open or closed. 

5. Relay state recording: when logging, the state of the control relay is recorded whenever 
the relay switches. 

GP1 Irrigation Monitor and Switch program: 

6. Control Page: the active state of the Control relay can be set to open or closed. 

7. Control Page: if irrigation control is enabled, and the deactivate condition is monitored 
more frequently than the normal recording rate, the program records soil moisture at the 
more rapid recording rate. This requires the deactivate condition to be monitored at a rate 
which is a divisor of the normal recording rate. 

8. Relay state recording: when logging, the state of the Control relay is recorded whenever 
the relay switches. 

Sunshine Recorder programs for GP1:  

9. SPN1 Sunshine Pyranometer: added SPN1 Sunshine recorder program. 

10. Recording options: added averaging and alternative irradiance and sunshine duration 
units to. 

11. Sample and recording rates: recording rate can be equal to sample rate, for recording 
instantaneous values. 

12. Battery life: power consumption is reduced and battery life increased by a factor of 5 
(approximately). This is achieved by a reduced warm up time. 



DeltaLINK 2.6 Release Notes 

20 July 2011, Copyright © 2005 - 2011 Delta-T Devices page 7 of 8  

  

Other changes: 

13. Printing correction: on some PC systems, printed charts contained missing point markers 
and/or partially printed charts with blacked out or blank areas. 

14. GSMConfig Utility: is now provided with DeltaLINK, for setting up modems for use with 
DL6 and GP1 loggers. 

15. Counter channels: when not logging, counter channels automatically reset when they 
overflow the maximum value stipulated for the channel. This change allows the user to 
use counter channels to control the relay (see below) and to exercise the relay operation 
before starting logging. Note that; 
a) previously, counter channels incremented indefinitely until reset, or logging started 
b) when logging, counters are only reset when recorded and this behaviour is unchanged. 

16. Dataset window: the Save As dialog doesn’t now save text files with the.dt6 suffix. 

17. Dataset and Sensors windows: provides a binary state chart for e.g. state of a Control 
relay. 

18. Networking: the Connection Properties dialog allows a logger serial number to be 
selected, for addressing an individual logger from a network. All loggers on a network 
need to have firmware version 1.30 or later. 

19. Modem communication: the communication protocol is more robust against extended 
pauses, such as can occur in GSM modem connections. 

20. File, Send To Logger: correctly refreshes Sensors and Program windows. Previously the 
Sensors window showed ‘garbage’ text, and the Program window could be left with a 
stale copy of the previously installed program. 

21. Closing DeltaLINK: closing the last window sometimes failed to shut down DeltaLINK, and 
sometimes caused an Application Error. 

Version 2.1 

Version 2.1 fully supports the DL6 logger (as well as the GP1) and replaces DL6 Control 
Panel, offering the following major additional features: 

1. Support for SM200 soil moisture sensor. 

2. Advanced Control option in Standard DL6 programs (requires firmware upgrade to 
version 1.27, see below). 

3. Imports linearization tables from user-defined .TBL files.  

Refer also to DeltaLINK Application Note ‘DL6 Control Panel, DeltaLINK and Timestamp 
Issues’ for advice about migrating to DeltaLINK. 

Additional improvements over Version 2.0 are: 

4. Supplied with firmware (GP1 and DL6) upgrades to version 1.27. See below for details. 

5. Improved estimation of dataset memory usage and predicted time to fill (requires 
firmware 1.27).  

Version 2.0 

This is the first public release of DeltaLINK for the GP1 logger.  

However Dataset Import Wizard is version 1.5, which differs from earlier versions which were 
supplied with DL2e, DL6 loggers and the HH2 meter. 

1. Dataset Import Wizard 1.5 offers ‘DeltaLINK dataset files’. 

2. Dataset Import Wizard 1.5, step 6, Options offers ‘Import serial number’, which includes 
DL6 or GP1 serial numbers in the header of each data series column and allocates 
separate columns for data series from different loggers.  
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GP1 and DL6 Firmware 

Version 1.48 

This is the current version of GP1 and DL6 firmware.  

Version 1.48 is required for the new features provided in DeltaLINK 2.4, and is incompatible 
with programs created in earlier DeltaLINK versions. 

Version 1.47 (GP1 only) 

1. Optimization of quiescent current consumption.  

Version 1.46 (GP1 only) 

1. Supports WS-GP1, WET sensor and other new features provided in DeltaLINK 2.3. 

Version 1.31 

1. Allows loggers to be individually addressed when connected together on a network. 

2. Prevents spurious switching of Alarm relays when Read Now is clicked in the Sensors 
window. This was caused by insufficient warmup time before the initial reading which 
controls the relay. 

Version 1.27 

1. Provides improved information about dataset memory usage, for use with DeltaLINK 2.1. 

2. Correction to DL6 relay switching, required for the Advanced Control feature. 

3. Is not vulnerable to crashing when used with DL6 Control Panel after being programmed 
with DeltaLINK. 

Version 1.25 (GP1 only) 

This is the first public release of GP1 firmware. 

Version 1.03 (DL6 only) 

1. Accuracy of resistance measurements is improved. 

Version 1.02 

This is the first public release of DL6 firmware. 
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